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1 | About this document

Blichi Labortechnik AG

1

1.1

1.2

1.2.1

1.2.2

About this document

This operation manual is applicable for all variants of the instrument.

Read this operation manual before operating the instrument and follow the
instructions to ensure safe and trouble-free operation.

Keep this operation manual for later use and pass it on to any subsequent user or
owner.

BUCHI Labortechnik AG accepts no liability for damage, faults and malfunctions
resulting from not following this operation manual.

If you have any questions after reading this operation manual:

» Contact BUCHI Labortechnik AG Customer Service.

https://www.buchi.com/contact

Warning notices in this document

Warning notices warn you of dangers that can occur when handling the device.
There are four danger levels, each identifiable by the signal word used.

Signal word Meaning

DANGER Indicates a danger with a high level of risk which could result in
death or serious injury if not prevented.

WARNING Indicates a danger with a medium level of risk which could result in
death or serious injury if not prevented.

CAUTION Indicates a danger with a low level of risk which could result in mi-
nor or medium-severity injury if not prevented.

NOTICE Indicates a danger that could result in damage to property.

Symbols

The following symbols are displayed in this operation manual or on the device:

Warning symbols

Symbol Meaning

é General warning

Dangerous electrical voltage

f Flammable substances

LASER CLASS 1 Laser class 1

LASER KLASSE 1

Mark-ups and symbols

NOTE

This symbol draws attention to useful and important information.

8/102
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1.3

1.4

M This character draws attention to a requirement that must be met before the
instructions below are carried out.

» This character indicates an instruction that must be carried out by the user.

= This character indicates the result of a correctly carried out instruction.

Mark-up Explanation

Window Software Windows are marked-up like this.
Tab Tabs are marked-up like this.

Dialog Dialogs are marked-up like this.

[Button] Buttons are marked-up like this.

[Field names] Field names are marked-up like this.
[Menu / Menu item] Menus or menu items are marked-up like this.
Status Status is marked-up like this.

Signal Signals are marked-up like this.
Trademarks

Product names and registered or unregistered trademarks that are used in this
document are used only for identification and remain the property of the owner in
each case.

Connected devices

In addition to these operating instructions, follow the instructions and specifications
in the documentation for the connected devices.

Operation Manual Pure Chromatography Instruments 9/102
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2.1

2.2

2.3

Safety

Proper use

The instrument is designed and built for laboratories.
The instrument can be used for the following tasks:

® Purification

® Separation of one or more compounds from a mixture

Use other than intended

Use of any kind other than that described in Chapter 2.1 "Proper use", page 10 and
any application that does not comply with the technical specifications (See
Chapter 3.5 "Technical data", page 18) constitutes use other than intended.

In particular, the following applications are not permissible:

® Use of the instrument in areas which require explosion-safe instruments.
® Use of the instrument with solvents containing peroxides.
® Use the ELSD without connected exhaust.

® Use the instrument for production purposes.

Staff qualification

Unqualified persons are unable to identify risks and are therefore exposed to greater
dangers.

The device may only be operated by suitably qualified laboratory staff.

These operating instructions are aimed at the following target groups:

Users
Users are persons that meet the following criteria:
® They have been instructed in the use of the device.

® They are familiar with the contents of these operating instructions and the
applicable safety regulations and apply them.

® They are able on the basis of their training or professional experience to assess
the risks associated with the use of the device.

Operator

The operator (generally the laboratory manager) is responsible for the following
aspects:

® The device must be correctly installed, commissioned, operated and serviced.

® Only suitably qualified staff may be assigned the task of performing the
operations described in these operating instructions.

® The staff must comply with the local applicable requirements and regulations for
safe and hazard-conscious working practices.

® Safety-related incidents that occur while using the device should be reported to
the manufacturer (quality@buchi.com).

10/102
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BUCHI service technicians

Service technicians authorized by BUCHI have attended special training courses and
are authorized by BUCHI Labortechnik AG to carry out special servicing and repair
measures.

2.4 Location of warning signs on the product

LASER CLASS 1

LASERKASSEY | T —— |

Fig. 1: Location of the warning signs

Laser class 1

2.5 Residual risks

The device has been developed and manufactured using the latest technological
advances. Nevertheless, risks to persons, property or the environment can arise if
the device is used incorrectly.

Appropriate warnings in this manual serve to alert the user to these residual
dangers.

2.5.1 Faults during operation

If a device is damaged, sharp edges, moving parts or exposed electrical wires can

cause injuries.

» Regularly check device for visible damage.

» If faults occur, switch off the device immediately, unplug the power cord and
inform the operator.

» Do not continue to use devices that are damaged.

2.5.2 Malware infection due to connections with other devices or network

Connections with other devices or a network can cause a malware infection to the

instrument.

» Install antivirus software and firewall on the instrument before connecting it to
other devices or network.

Operation Manual Pure Chromatography Instruments 11/102
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2.5.3 Damage to the internal memory due to incorrect shutting down of the
instrument

Incorrect shutting down of the instrument can cause damage to the internal
memory.
» Shut down the instrument as described. See Chapter 6 "Operation", page 33

2.6 Personal protective equipment

Depending on the application, hazards due to heat and/or corrosive chemicals may

arise.

» Always wear appropriate personal protective equipment such as safety goggles,
protective clothing and gloves.

» Make sure that the personal protective equipment meets the requirements of
the safety data sheets for all chemicals used.

2.7 Modifications

Unauthorized modifications can effect safety and lead to accidents.

» Use only genuine BUCHI accessories, spare parts and consumables.

» Carry out technical changes only with prior written approval from BUCHI.
» Only allow changes to be made by BUCHI service technicians.

BUCHI accepts no liability for damage, faults and malfunctions resulting from
unauthorized modifications.

12/102 Operation Manual Pure Chromatography Instruments
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3 Product description

3.1 Description of function

Pure instruments are purification devices designed to purify complex samples by
either flash chromatography, prep chromatography or by both.

® Flash chromatography has the ability to separate gram size samples in short
period.

® Prep-HPLC has the ability to separate complex samples at high resolution.

Pure instruments allow:

® 4 different solvents

® |njection of liquid or solid sample

® Separation on a cartridge or column

e |dentifying the compounds by UV and/or ELS detection

® Collecting the desired fractions

Pure instrument schematic:

Solvent 1 ELSD
(@)
Solvent 2 ® %
S a
[} Q uv Fraction
3 .
z o detector collection
S ]
Solvent 3 S %
Sample >
introduction
Solvent 4 |

Operation Manual Pure Chromatography Instruments 13/102
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3.2 Configuration

3.2.1 Front view Pure C-810 / C-815

e

Fig. 2: Front view Pure C-810 / C-815

1
3
5
7

Control panel
On/Off switch
Injection port

Flash pump

ELSD nebulizer
(C-815 only)

RFID reader
USB Port
Cartridge holder

o oo b~ N

ELSD flow split valve
(C-815 only)

10 Fraction collection bay

14/102

Operation Manual Pure Chromatography Instruments



Buichi Labortechnik AG Product description | 3

3.2.2  Front view Pure C-830 / C-835 / C-850

Fig. 3: Front view Pure C-830 / C-835 / C-850

1 Control panel 2 RFID reader
(C-850 only)
3 On/Off switch 4 USB Port
5 Column holder 6 Prep HPLC pump
7 ELSD flow split valve 8 ELSD nebulizer
(C-835 / C-850 only) (C-835/ C-850 only)
9 Prep sample injection valve 10  Fraction collection bay

3.2.3 Rear view

d NOTE

All electrical connections are not limited energy.

Operation Manual Pure Chromatography Instruments 15/102
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Fig. 4: Rear view

1

Ventilation slot

Exhaust
(used for instruments with ELSD
only)

USB ports
Fuse

Pressurized air inlet

2 Gradient valve

(See Chapter 3.2.4 "Connections on
gradient valve", page 17)

4 Signal connection
(for external air supply)

6 Power supply connection
8  On/Off master switch
10 LAN port

16/102
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3.2.4 Connections on gradient valve

\
\
@=o o \ \ | D! /
@ S,
I
Iy

Fig. 5: Connections on the rear side

1 Wasteline 2 Solventline 4

3 Solventline 3 4  Waste level sensor

5 Solventline 2 6 Solventline 1

7 Solvent level sensor line 1 8 Solvent level sensor line 2
9 Solvent level sensor line 3 10 Solvent level sensor line 4

3.3 Type plate

The type plate identifies the instrument. The type plate is located at the rear of the
instrument.

Operation Manual Pure Chromatography Instruments 17/102
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Fig. 6: Type Plate

1 Company name and address 2 Instrument name

3 Serial number 4 Input voltage range

5 Frequency 6 Power consumption maximum

7  Year of manufacture 8 Product code

9 Approvals 10 Symbol for "Do not dispose of as

household waste"

3.4 Scope of delivery

d NOTE

The scope of delivery depends of the configuration of the purchase order.

Accessories are delivered as per the purchase order, order confirmation, and
delivery note.

3.5 Technical data

3.5.1 Pure Chromatography Instruments

Pure Pure Pure Pure Pure

c-810 C-815 C-830 C-835 C-850
Dimension 365x570x 365x570x 365x570x 365x570x 365x570x
(WxDxH) 680 mm 680 mm 680 mm 680 mm 680 mm
Weight 25 kg 27 kg 31 kg 33 kg 33 kg

Power consumption 350 W 350 W 350 W 350 W 350 W

Connection voltage 100-240V 100-240V 100-240V 100-240V 100-240V
+10% +10% +10% +10% +10%

Frequency 50-60Hz 50-60Hz 50-60Hz 50-60Hz 50-60Hz
Fuse 4 A 4A 4 A 4A 4A

Overvoltage cate- |l Il Il I Il
gory

18/102 Operation Manual Pure Chromatography Instruments
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Pure Pure Pure Pure Pure
c-810 C-815 C-830 C-835 C-850
Pollution degree 2 2 2 2 2
IP Code IP 20 IP 20 IP 20 IP 20 IP 20
Solvents 4 4 4 4 4
Gas pressure 8 bar 8 bar 8 bar 8 bar 8 bar
( maximum)
Compressed air oil and dust oil and dust oil and dust oil and dust oil and dust
free free free free free
USB port 3 3 3 3 3
LAN port 1 1 1 1 1
(RJ45)
RFID reader Yes Yes Yes Yes Yes
(racks)
RFID reader Yes Yes No No Yes
(cartridges)
Fraction collector  closed closed closed closed closed
bay
Lighted fraction col- Yes Yes Yes Yes Yes
lector bay
Solvent level sensor Yes Yes Yes Yes Yes
Waste level sensor  Yes Yes Yes Yes Yes
Vapor sensor Yes Yes Yes Yes Yes
Pump Flash Mode
Pure Pure Pure Pure Pure
c-810 C-815 C-830 C-835 C-850
Gradient binary binary - - binary
Pressure range 0-50bar O0-50bar - - 0-50 bar
Flow rate 0-250mL/ 0-250mlL/ - - 0-250 mL/
min min min
Flow rate accuracy <2 % <2% - - <2%
Functional principle self-priming self-priming - - self-priming
Specification 3 pistons 3 pistons - - 2 pistons
radial ar-  radial ar- parallel ar-
ranged ranged ranged
Pump Prep Mode
Pure Pure Pure Pure Pure
c-810 C-815 C-830 C-835 C-850
Gradient - - binary binary binary
Operation Manual Pure Chromatography Instruments 19/102
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3.5.2

Pure Pure Pure Pure Pure
c-810 C-815 C-830 C-835 C-850
Pressure range - - 0-300 bar  0-300 bar  0-300 bar
Flow rate - - 0-100ml/ 0-100ml/ 0-100ml/
min min min
Flow rate accuracy - - <2% <2% <2%
Functional principle - - self-priming self-priming self-priming
Specification - - 2 pistons 2 pistons 2 pistons
parallel ar- parallel ar- parallel ar-
ranged ranged ranged
UV Detector
Pure Pure Pure Pure Pure
c-810 C-815 C-830 C-835 C-850
UV - Vis wavelength 200-800 200-800 200-800 200-800 200 -800
range nm nm nm nm nm
Light sources Halogen/ Halogen/ Halogen/ Halogen/ Halogen/
Deuterium Deuterium Deuterium Deuterium Deuterium
Lifetime lamp 2000 hours 2000 hours 2000 hours 2000 hours 2000 hours
Detector DAD DAD DAD DAD DAD
DAD scan entire entire entire entire entire
range range range range range
ELSD Detector
Pure Pure Pure Pure Pure
c-810 C-815 C-830 C-835 C-850
Light output laser - 0.3 mwW - 1mw 1mw
Pressure carrier air - ~0.8 bar - ~0.8 bar ~0.8 bar
Pressure spray air - 3-3.5bar - 3-3.5bar 3-3.5bar
Flow rate air - 2-251/ - 2-25L1/ 2-25L/
min min min
Ambient conditions
For indoor use only.
Max. altitude above sea level 2000 m

Ambient temperature

5-40°C (25°C)

No maximum performance above 25°C

Maximum relative humidity

80% non-condensing, for temperatures

up to 31°C

Storage temperature

max. 45 °C

20/102
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3.53

Material

Component Materials of construction
Housing Powder coated steel 1.4301
Fraction collection bay PMMA / PET

Pump head PEEK

Pump cover PP

Pump excenter housing Aluminum

Tubings FEP

Fitting POM

Valve screw fitting POM

Ferrule ETFE

Cone ring POM

Radial seal PTFE

Pistons Ceramic

Operation Manual Pure Chromatography Instruments
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4

4.1

A

4.2

Transport and storage

Transport

NOTICE

Risk of breakage due to incorrect transportation

» Make sure that all parts of the device are safely packed in such a way as to
prevent breakage, ideally in the original box.

» Avoid sharp movements during transit.

» After transportation, check the device for damage.

» Damage that has occurred in transit should be reported to the carrier.

» Keep packing for future transportation.

Storage

» Make sure that the ambient conditions are complied with (see Chapter 3.5
"Technical data", page 18).

» Make sure a clean solvent like ethanol or isopropanol is in the pump.

» Wherever possible, store the device in its original packaging.

» After storage, check the device, all seals and tubing for damage and replace if

necessary.

22/102
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4.3 Lifting the instrument
A _
Danger due to incorrect transportation

The possible consequences are crushing injuries, cuts and breakages.

» The instrument should be transported by two persons at the same time.
» Lift the instrument at the points indicated.

I

» Lift the instrument — this requires two persons each lifting at one of the points
indicated on the bottom of the instrument.
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5.1

A

5.2

5.3

Installation

Before installation

NOTICE

Instrument damage due to switching it on too early.
Switching on the instrument too early after transportation can cause damage.

» Climatize the instrument after transportation.

Installation site
The installation site must meet the following requirements:
® Firm, level surface.

® Take into account the maximum product dimensions and weight. See Chapter 3.5
"Technical data", page 18

® Clearance on each side of the instrument must be at least 200 mm.

® Do not expose the instrument to any external thermal loads, such as direct solar
radiation.

® Do not expose the instrument to increased electromagnetic emissions.
Electromagnetic fields in the frequency range between 200 to 300 MHz can cause
the instrument to operate incorrectly.

® Make sure that the installation site meets the requirements of the safety data
sheets for all solvents and samples used.

NOTE

Make sure that the power supply can be disconnected at any time in an emergency.

Securing against earthquakes

The instrument has an earthquake fixing point to protect the device against falling.

J

» Tie the lashing mount to a fixed point using strong cord or a wire.

P

Fig. 7: Securing against earthquakes

1 Fixing point
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A

5.5

A

Establishing electrical connections

NOTE

Observe the legal requirements when connecting the instrument to the power
supply.

» Use additional electrical safety features (e.g., residual-current circuit breakers) to
comply with local laws and regulations.

The power supply must fulfil the following conditions:
1. Provide the mains voltage and frequency specified on the type plate of the
instrument.

2. Be designed for the load imposed by the instruments connected.
3. Be equipped with suitable fuses and electrical safety features.

4. Be equipped with proper earthing.

NOTICE

Risk of property damage and diminished performance due to use of unsuitable
power cables.

The power supply cables supplied with the product by BUCHI precisely match the
requirements of the device. If other power cables that do not meet those
requirements are used, the device may be damaged and/or its performance
diminished.

» Use only the power supply cables supplied with the product or ordered
separately from BUCHI.

» If using any other power supply cables, make sure that they match the
specifications on the type plate.

» Make sure that all connected devices are earthed.

» Plug the power cable into the connection on the instrument. See Chapter 3.2
"Configuration", page 14

» Plug the mains plug into the mains outlet socket.

Establishing solvent connection

NOTICE

Solvent bottles on top of the instrument.
Solvent bottles on top of the instrument can cause property damages.

» Locate the solvent bottles next to the instrument.
» Use the optional solvent bottle platform.
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Precondition:
I Make sure that the instrument is not
connected to the power supply.

» Attach all solvent lines to the
instrument. Connections see
Chapter 3.2.4 "Connections on gradient
valve", page 17

» Put the other end of the solvent line
into the solvent bottle.

» Assign the solvent to the solvent lines.
See Chapter 5.7 "Assigning solvent to
solvent lines", page 26

» Install the solvent level sensor. See
Chapter 5.6 "Installing the solvent level
sensor", page 26

5.6 Installing the solvent level sensor

Precondition:
M Make sure that the instrument is not
connected to the power supply.

» Attach all solvent level sensors to the
instrument. Connections see
Chapter 3.2.4 "Connections on gradient
valve", page 17

» Calibrate the solvent level sensors. See
Chapter 5.8 "Calibrating the solvent
level sensor", page 27

5.7 Assigning solvent to solvent lines

! | — ]
2 I | |
:
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Navigation path

=> Tools = Solvent Loading

Precondition:
M The solvent bottle is connected to the instrument. See Chapter 5.5 "Establishing
solvent connection", page 25
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5.8

M The solvent you wish to use is part of the solvent library. See Chapter 6.3 "Editing
a solvent", page 53

» Navigate to the So/vent Loading dialog according to the navigation path.

= The display shows the dialog box So/vent Loading.

» Tap the drop-down list next to Line 1.

= The display shows a drop-down list with selectable solvents.
» Select the solvent which is connected to solvent line 1.

= The solvent for Line 1 is assigned.

= The drop-down list closes.

Repeat the solvent selection for each line.

Activate the checkbox next to the line you wish to prime.
Tap the button [Auto Prime].

Wait till priming finished.

Tap the button [Close].

= All lines are assigned with solvents.

vvVvyyvVvyy

= The dialog box closes.

Calibrating the solvent level sensor
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Navigation path

= Tools = Calibration and Defaults

Precondition:
M The solvent level sensor is not covered by solvent.

» Navigate to the Calibration dialog according to the navigation path.

= The display shows the dialog box Calibration.

» Tap [Zero] for the related solvent line.
» Tap the button [Close].

= The dialog box closes.
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5.9 Installing the exhaust (ELSD only)

» Press the exhaust gas hose (2) on the
exhaust (1).

N

5.10 Assembling the waste bottle

A NOTICE

Waste bottle on top of the instrument
Waste bottle on top of the instrument can cause property damages.

» Make sure that there is a decline between the connection on the instrument and
the waste bottle.

» Put the waste line into the waste bottle.

5.11 Installing the waste level sensor

Precondition:
M Make sure that the instrument is not
connected to the power supply.

» Attach the waste level sensor to the
instrument. Connections see
Chapter 3.2.4 "Connections on gradient
valve", page 17

» Calibrate the waste level sensor. See
Chapter 5.12 "Calibrating the waste
level sensor", page 29
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5.12  Calibrating the waste level sensor
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Navigation path

=> Tools = Calibration and Defaults

Precondition:
VI The waste level sensor is not covered by liquid waste.

» Navigate to the Calibration dialog according to the navigation path.

= The display shows the dialog box Calibration.

» Tap [Zero] for [Waste].
» Tap the button [Close].

= The dialog box closes.
5.13 Assembling the dry air supply (option)

» Connect the signal cable from the air
supply to the instrument.

» Connect the gas connection. See
Chapter 5.14 "Assembling the gas
connection (option)", page 30.
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5.14

Assembling the gas connection (option)

Precondition:

M The gas supply complies with the
specifications. See Chapter 3.5 "Technical
data", page 18

» Cut 50 mm from the gas tubing.

» Attach the cut tubing to the air filter.

» Secure the tubing in place.

» Attach the tubing from gas supply to the other
side of the air filter.

» Secure the tubing in place.

» Connect the tubing from the gas supply to the
instrument.
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5.15 Assembling the solvent bottle platform (option)

A NOTICE

Waste bottle on top of the instrument
Waste bottle on top of the instrument can cause property damages.

» Do not place the waste bottle an the solvent bottle platform.

» Turn the solvent bottle platform upside down.

» Attach the drain line adapter to the solvent
bottle platform

» Attach the drain line to the drain line adapter.

» Attach the solvent bottle platform to the D
instrument with screws. |
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5.16 Assembling the sample loop (Prep instruments only)

» Attach the sample loop to the
instrument at the position indicated.
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6 Operation

6.1 Control panel

6.1.1 Layout of control panel
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Fig. 8: Display

No. Description Function

1 [Menu] bar Shows the available menus.
See Chapter 6.1.3 "Menu bar", page 35

2 [Conditions] panel Shows the properties and default settings
of the installed column / cartridge.
See Chapter 6.1.4 "Conditions panel",
page 37

3 [Wavelength] panel Shows available wavelengths and scan
options.

4 [Collection] panel Shows collection options.
See Chapter 6.1.5 "Collection panel",
page 38

5 [Gradient] panel Shows chromatograms and gradient ta-
ble.
See Chapter 6.1.6 "Gradient panel",
page 39

6 [Run] panel Shows the operation options.

See Chapter 6.1.7 "Run panel", page 40
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No. Description Function

7 [Solvent selection] panel Shows selectable solvents.
See Chapter 6.1.8 "Solvent selection
panel", page 41

8 [Detector settings] panel Shows selectable detector options and its
settings.
See Chapter 6.1.9 "Detector selection
panel", page 41

9 [Slope detection] panel Shows selectable slope detection options.
See Chapter 6.1.10 "Slope detection
panel", page 42

6.1.2 Enter value

Enter numbers
» Tab on an entry field.

Min: 0.0 Max: 200.0

7 8 || 9 || Back

4|/ 5| 6| Del

123‘4-

0 ‘—-

OK

= The display shows a dialog box with a numeric input box.

» Enter the value.
» Tap the button [OK].

= The value is saved.
= The dialog box closes.

Enter names
» Tab on an entry field.

qilwilel|r|t|yi|ulil]ol]p]|Back
z|x|lcffvi{b{|n|m]|, | .| / |Entr

Shift Space +« | - | OK

= The display shows a dialog with an alphanumeric input box.

» Enter the value.
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6.1.3

» Tap the button [OK].

= The value is saved.

= The dialog box closes.

Menu bar

The following menus are available:

Menu Submenu / Action Explanation
[File] [Open Method] Load an existing method.
See Chapter 6.4.6 "Selecting an existing
method", page 61
[Save Method] Save an edited method.
See Chapter 6.2.10 "Saving a method",
page 52
[Save Method as] Save an edited method with another
name.
See Chapter 6.2.10 "Saving a method",
page 52
[Open Run] Load a completed run.
[Print Run Report] See Chapter 6.10.1 "Printing a run re-
port", page 71
[Print PDF to USB] See Chapter 6.10.3 "Sending PDF to USB",
page 72
[Exit] Exit the Pure software to Windows® sys-
tem software.
[Shut down] The instrument shuts down.
[Mode] [Flash] Select the Flash mode.
See Chapter 6.5.2 "Selecting the flash
mode (Pure C-850 only)", page 62
[Preparative] Select the Prep mode.
See Chapter 6.7.2 "Selecting the prep
mode (Pure C-850 only)", page 66
[View] [Setup] If [Setup] is marked up, the instrument is

in setup mode.

[Run in Progress]

If [Run in Progress] is marked, a run is in
progress.

[Past Run]

If [Past Run] is marked up, the instrument
is in the past run mode.

Operation Manual Pure Chromatography Instruments
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Menu

Submenu / Action

Explanation

[Tools]

[Solvent Loading]

Assign a solvent to a solvent line.
See Chapter 5.7 "Assigning solvent to sol-
vent lines", page 26

[Solvent Definition]

Define solvents.

See Chapter 6.3 "Editing a solvent",
page 53

[Vapor Sensors and Limits]

Edit the vapor sensor sensitivity.
See Chapter 6.2.9 "Editing the vapor sen-
sor sensitivity", page 52

[Configuration]

System configurations.

[Calibration and Defaults]

Calibrate the screen.

Set time and date.

Reset UV lamp.

Calibrate solvent level sensors.

See Chapter 5.8 "Calibrating the solvent
level sensor", page 27

Calibrate the waste level sensor.
See Chapter 5.12 "Calibrating the waste
level sensor", page 29

Set alarms

[Manual control]

Maintenance actions.

See Chapter 7.6 "Cleaning the instru-
ment", page 77

See Chapter 7.7 "Cleaning the solid
loader", page 78

See Chapter 7.8 "Removing solvent from
an used cartridge", page 78

See Chapter 8.8 "Resetting the Fraction
collector arm", page 89

[NP<>RP]

Change back and forth between normal
phase and reverse phase

[Product Services]
(C-810 C-815 C-850 only)

Override max. pressure limit for car-
tridges.

[UV Baseline]

Adjust the baseline to zero during a run.

[Language]

Select a language.

[Service]

BUCHI service technicians only

[Help]

[About]

The display shows instrument details.

[View Manual]

The display shows the Operation manual.
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6.1.4

Conditions panel
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1 Information button
(Information about the selected col-
umn)
The conditions area contains the following settings:
Action Option Explanation
[Column] Enter value Enter a name for the present car-
(Prep mode) tridge.
[Column] Select column /auto- Shows the name of the column in-
(Flash mode) matic via RFID stalled in the instrument.
[Flow Rate] Enter value Edit the default flow rate.

[Duration Units]

Choice of the duration
type

The following types are available:
minutes / column volumes

[Equilibration] Enter value Indicates the period of time or num-
ber of column volumes that the mo-
bile phase flows through the column
before the sample is injected.

[Run Length] Enter value According to the current operation

enter the time for the separation.

According to the current operation
enter the number of column volumes
required for the separation.

Operation Manual Pure Chromatography Instruments
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Action Option Explanation

[Air Purge Time] Enter value Indicates the period of time that air
is passed through the column after
the separation to remove mobile
phase

6.1.5 Collection panel

1 Tray number

The collection vial matrix corresponds to the trays. The trays are detected by the
auto recognition. The estimated number of vials required for the separation is
displayed below the solvent usage list in the lower left corner of the Setup window.
The fraction collection area contains the following settings:

Action Option Explanation

Fraction collection Select value The following options are available:

options [Collect Peaks] / [Collect All] / [Collect
None]

[Per-Vial Volume]  View / Enter value The following values are changeable:

[Peak] / [Non-Peaks]
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6.1.6 Gradient panel

Edit the gradient and see separation details.

d NOTE

According to the instrument status different options are available.

Action Option Explanation
[Table] Create a gradient See Chapter "Editing the gradient in
tabular mode", page 46
[Navigator] Finding out Flash sepa- See Chapter 10.3 "Finding out sepa-
ration conditions ration conditions with the navigator",
page 97
[UV scan details] View Shows the following charts:

® 3D (UV / Time/ Wavelength)
® 2D (Time / Wavelength)
® Absorption maxima

® All scan maxima

[Zoom] Function Zoom the graph.

[Options] Select values Graph options.

[Edit] Select between the op- The graph is in edit mode. See Chap-
tions ter "Editing the gradient in graphic

mode", page 47

[View] The graph is in view mode.
(No changes possible)

[Zoom] Zoom the graph.
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Action Option Explanation

[Gradient hold] Function The gradient is held at the current
solvent ratio.

The gradient continues to the origi-
nal end-point.

[Auto gradient hold] Function The gradient will be held every time
the signal goes over the set thresh-
old.

6.1.7 Run panel
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The run panel shows available functions according to the current operation.

Symbol Description Meaning

_ [Start] Is used to start the run or re-start the
actual operation if the system has
been paused.

_ [Stop] Is used to terminate the operation of
the system.

_ [Pause] Is used to stop the actual operation.
If the system is paused due to an er-
ror, this button will change to yellow.

_ [Advance] Is used to advance to the next step

during equilibration.
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6.1.8 Solvent selection panel

20

Select solvents for a separation. See Chapter 6.2.3 "Selecting a solvent", page 45

6.1.9 Detector selection panel
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Action Option Explanation
[ELSD] Enable / Disable Action enabled:
Select value Select between Low / High

Enter values for threshold

Action disabled:
No selection

Operation Manual Pure Chromatography Instruments
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6.1.10

6.2
6.2.1

Action Option Explanation
[uV] Enable / Disable Action enabled:
Select value / Enter Low / High
value Enter values for threshold

Action disabled:
No selection

[Threshold Detec-  Enter value
tion]

The threshold defines the value
above the fraction collector starts to
collect fractions.

Slope detection panel
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Action Option Explanation

[Slope detection] Enable / Disable

Action enabled:

Fraction collection triggered by slope

Action disabled:
No detection

Editing a method

Selecting a cartridge (Flash mode)

NOTE

The automatic reading of the cartridge information can only be done with specific

BUCHI RFID tagged cartridges.

» The indication for recognizing the cartridge is a sound.

42/102
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20 e

1 Information button
(Information about the selected col-
umn)

Navigation path

=> Conditions panel

» Navigate to the Conditions selection panel according the navigation path.
» Tap the input box next to [Column].
= The display shows a menu with selectable cartridges.

» Select the cartridges you wish to use.

Operation Manual Pure Chromatography Instruments 43/102



6 | Operation Buchi Labortechnik AG

6.2.2 Selecting a column (Prep mode)
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1 Information button

(Information about the selected col-
umn)

Navigation path

=> Conditions panel

» Navigate to the Conditions selection panel according the navigation path.
» Tap the input box next to [Column].

= The display shows a dialog with an alphanumeric input box.
» Enter a name for the column.

» Tap the button [OK].

» Tap the input box next to [Flow rate].

= The display shows a dialog box with a numeric input box.

» Enter a value for the flow rate.

» Tap the button [OK].

» Tap the input ox next to [Max. Pressure].

= The display shows a dialog box with a numeric input box.

» Enter the maximum pressure for the column.
» Tap the button [OK].

44/102 Operation Manual Pure Chromatography Instruments



Blichi Labortechnik AG

Operation | 6

6.2.3

6.2.4

Selecting a solvent

20

Navigation path

=> Solvent selection panel

Precondition:

M The required solvents lines are connected and assigned. See Chapter 5.7
"Assigning solvent to solvent lines", page 26

» Navigate to the So/vent selection panel according the navigation path.

» Tap the drop-down list next to A: .

= The display shows a drop-down list with the assigned solvents.

» Tap the required solvent.

= The solvent is selected

= The drop-down list closes.

» Select more solvents for the mobile phase according to your needs.

Editing the gradient

The composition of the mobile phase as a function of time can be indicated by
entering the gradient. Four solvent lines can be used to generate a binary gradient.
The solvents used to define the gradient can be altered during the separation.
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Editing the gradient in tabular mode
|
15 0.0}aB Y 0
2 | 10048 Y| 100
The following settings are available:
Action Option Explanation
[Min] Enter value Enter the time until the value in col-
umn [% 2nd] is reached.
[Solvents] Select value Select solvent line combinations.
[% 2nd] Enter value Enter the percentage rate for the

second solvent.

Navigation path

=> Gradient panel

» Navigate to the Gradient panel according the navigation path.

» Tap the button [Table].

= The display shows the dialog Gradient Table.

» Tap the cell for [Min].

= The display shows a dialog box with a numeric input box.
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» Enter the time.
» Tap the button [OK].
» Tap the cell for [ABV].

= The display shows a drop-down list with solvent line combinations.

» Select the combination that you want to use.
» Tap the cell for [% 2nd].

= The display shows a dialog box with a numeric input box.

» Enter the percentage for the second solvent.
» Tap the button [OK].
» Tap the button [Close].

= The gradient is saved
= The dialog Gradient table closes

= The Gradient panel shows the set gradient.

Add additional lines to the Gradient table

» Tap the number field (e.g. 1»).

= The display shows a drop-down list with selectable actions.

» Select if the line should be added above or below the selected line.
= Aline is added.

Deleting lines from the Gradient table

» Tap the number field (e.g. 1»).

= The display shows a drop-down list with selectable actions.
» Select delete.

= The line is deleted.

Editing the gradient in graphic mode

Navigation path

=> Gradient panel

» Navigate to the Gradient panel according the navigation path.
» Tap the button [Edit].

= The Display shows a drop-down list.

» Select [Edit].

Add steps to the Gradient graphic

» Tap on the line at the time for which you want to edit the gradient and drag it to
the desired %B, then release.

Deleting steps from the Gradient graphic

» To remove a step, drag the point to the baseline or to any gray area around the
graph until a red X is visible, then release.
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Change solvent combinations
» Solvent line combinations can be accessed by clicking on the ABV box to reveal a
drop-down list.
6.2.5 Editing detector selection
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Navigation path
=> Detector selection panel
» Navigate to the Detector selection panel according the navigation path.
» Activate checkbox for the detector you wish to use.
= The detector is activated.
6.2.6 Editing the wavelength for the UV detector

40
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Status Checkbox Explanation Explanation

\/ On The instrument collects fractions.

. Monitoring The instrument records the data from the
UV detector but does not collect the frac-
tions.

Off The instrument does not record data
from the UV detector and does not col-

lect fractions.

Navigation path

=> Wavelength selection panel

Precondition:

I The UV detector is selected.
» Navigate to the Wavelength panel according the navigation path.
» Activate the checkbock next to [UV].

» Tap the input box next to [UV].

= The display shows a dialog box with a numeric input box.

» Enter a value for the wavelength.

» Tap the button [OK].

= The dialog box closes.

= The wavelength is saved.

6.2.7 Editing the fraction collection criteria

Cd [']

1 Identifier
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6.2.8

The following fraction collection criteria are available:

Criteria Meaning

[Collect Peaks] The instrument collects fractions if one detector signal is
above the set threshold.

[Collect All] The instrument collects all the fractions regardless of de-
tection signals.

[Collect None] The instrument collects no fractions.

NOTE

[Peak] and [Non-Peaks] default is the maximum volume of the vial.

Navigation path

=> Collection panel

» Tap the radio button next to criteria you wish to use.

= The criteria is selected.

» Tap the input box next to [Peak].

= The display shows a dialog box with a numeric input box.

» Enter a the volume you wish to collect.
» Tap the button [OK].

= The dialog box closes.

= The value for the volume is saved.

» Tap the input box next to [Non-Peaks].

= The display shows a dialog box with a numeric input box.

» Enter the volume you wish to collect.
» Tap the button [OK].

= The dialog box closes.

Editing the fraction collection time
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Program Collect allows to turn off fraction collection for a specific time.

The fraction collector defaults to collect the full run length unless the values from

Program Collect override the collection.

o]  of o

[ ]

Navigation path

=> Gradient panel

» Navigate to the Gradient panel according the navigation path.
» Tap the button [Program collect].

= The display shows the dialog Program collect.

» Tap the input box.

= The display shows a dialog box with a numeric input box.

» Enter the time.
» Tap the button [OK].

= The time is saved.
= The dialog box closes.

Add additional lines to the program collection

» Tap the number field (1»).
= The display shows a drop-down list with selectable actions.

» Select if the line should be added above or below the selected line.

= Alineis added.

Deleting lines from the program collection

» Tap the number field (1»).

= The display shows a drop-down list with selectable actions.
» Select delete.

= The line is deleted.

Operation Manual Pure Chromatography Instruments
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6.2.9 Editing the vapor sensor sensitivity

3542 a70

 —
[]

The vapor sensor detects solvent concentration in the ambient air.
The following sensitivity limits are available:

Sensitivity Meaning

High Used for non-volatile solvents

Medium Compromise between the low and high setting
Low Used for volatile or semi-volatile solvents

Off The vapor sensor is off

Navigation path

=> Tools = Vapor Sensor and Limits

» Navigate to the Vapor Sensors dialog according to the navigation path.

= The display shows the dialog box Vapor Sensors.

» Tap the drop-down list next [Vapor alarm sensitivity].
» Select the sensitivity value you wish to use.
» Tap the button [Close].

= The dialog box closes.

6.2.10 Saving a method

—
1

1

]

Navigation path

-> File = Save Method as
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6.3
6.3.1

» Navigate to the Save Method as dialog according to the navigation path.

= The display shows the dialog box Save Method as.
» Tap the input box [Enter method name].
= The display shows a dialog with an alphanumeric input box.

» Enter the name of the method.
» Tap the button [OK].

= The dialog box closes.
» Tap the button [OK].

= The method is saved.
= The dialog box closes.

Editing a solvent
Adding a new solvent
3 C1

|

L]

Navigation path

=> Tools = Solvent Definition

» Navigate to the So/vent Definition dialog according to the navigation path.

= The display shows the dialog box Sol/vent Definition.

» Tap the button [Add Solvent].

= The display shows the dialog box So/vent.

» Tap the input box next to [Name].

= The display shows a dialog with an alphanumeric input box.

» Enter the name for the solvent.
» Tap the button [OK].

= The dialog box closes.
» Tap the input box next to [Info].
= The display shows a dialog with an alphanumeric input box.

» Enter information to the solvent according to your requirements.
» Tap the button [OK].

= The dialog box closes.
» Tap the button [Verify Solvents].

= The display shows the dialog box So/vent Verification.
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» Select solvent group for the defined solvent.
» Tap the button [OK].

= The dialog box closes.
= The solvent is added.
» Tap the button [Close].

= The dialog box Sol/vent Definition closes.

6.3.2 Deleting a solvent

—
o

L]

L]

Navigation path

=> Tools = Solvent Definition

» Navigate to the So/vent Definition dialog according to the navigation path.

= The display shows the dialog box Sol/vent Definition.

» Select the solvent you wish to delete.
» Tap the button [Delete Solvent].
» Answer the secure question with [Yes].

= The solvent is deleted.

6.4 Tasks during a separation

6.4.1 Introducing a sample into the prep system

» Connect the syringe at the sample loop
port.
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» Press the plunger.

» Wait until the run starts.

» Disconnect the syringe at the inert loop
port.

6.4.2 Injecting a sample into the flash system

Injecting a sample into the flash system at the luer port

A A CAUTION

Not removed syringe after injection.
A not removed syringe after injection can lead to spill of solvent and injuries.

» Remove the syringe after injection.
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» Connect the syringe at the luer port.

» Press the plunger.

/

» Disconnect the syringe at the luer port.

Injecting a sample into the flash system with a solid loader

d NOTE

Removing is done in reverse sequence.

» Loosen the solvent line on the top of
the cartridge holder.

/
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» Attach the solid loader to the cartridge \\(/
holder.

» Attach the solvent line to the solid
loader.

6.4.3 Installing and removing a cartridge

NOTE

Removing is done in reverse sequence.

NOTE

Instead of a cartridge a bypass can be installed.

NOTE

The automatic reading of the cartridge information can only be done with specific
BUCHI RFID tagged cartridges.

» The indication for recognizing the cartridge is a sound.

» Hold the cartridge above the RFID
reader.

» Wait until the instrument has taken
over the cartridge data.
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» Lift the clamping plate to release the
lock mechanism and pull up the upper
part of the cartridge holder.

» Install the cartridge by pushing the
cartridge inlet down into the luer
fitting at the bottom plate.

A\
(=
17r—7

[ L]/

» Lower the upper part of the cartridge
holder over the luer connection.

» Align it.

» Firmly press the arm in place to ensure
a proper seal.

L4

AN

NN

/

6.4.4 Installing and removing a column

d NOTE

Removing is done in reverse sequence.
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» Install the column in the bottom plate
of the column holder.

» Lower down the upper part of the
column holder.

» Remove the tubing from the upper part
of the column holder.

/
7

» Attach the tubing to the column.
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» Remove the lower tubing from the N %
upper part of the column holder. \ I

/

» Attach the tubing to the column.

6.4.5 Inserting the fraction collection tray

d NOTE

By default the first available tube on each tray is reserved for waste.

Changing the setting. See Chapter 6.4.7 "Selecting values on the dialog box Sample
Loading", page 61

&

>

Optical sensor slot

A
M

1 Tab 2

» Place the collection tubes in the collection tray.
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» Place the trays in the fraction collector bay.
» Make sure that the tab is in the optical sensor slot.

6.4.6 Selecting an existing method

Navigation path

=> File = Open Method

» Navigate to the Open Method dialog according to the navigation path.

= The display shows the dialog box Open Method.

» Select the method you wish to use.
» The display highlights the selected method black.
» Tap the button [OK].

= The method is selected.
= The dialog box closes.

6.4.7 Selecting values on the dialog box Sample Loading

The display shows the dialog box Sampl/e Loading during the starting phase of a

separation.
The following settings are possible:

Action Explanation

[Lower flow rate for Reduce flow rate for a specified period, when the pressure
specified time after in-  increases significantly at the start of the run after sample
jection] injection.

[Flush 2nd solvent at the Automatically cleaning the system and column.
end of the run]

[Override Start Vial] Select the start vial according to your needs.

6.5 Performing a Flash separation using a method

d NOTE
Pure C-810/ C-815 / C-850 only

6.5.1 Preparing the instrument

Time required: approx. 30 sec.

Precondition:

M All commissioning operations have been completed. See Chapter 5 "Installation",
page 24

» Switch the On/Off master switch to On.

» Tap the On/Off switch.

= The instrument is starting up.
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6.5.2 Selecting the flash mode (Pure C-850 only)

Navigation path

- Mode

» Navigate to the Mode menu according to the navigation path.
» Select [Flash].
= The flash mode is selected.

6.5.3  Starting Flash separation using a method

Precondition:

M The instrument is prepared. See Chapter 6.5.1 "Preparing the instrument",
page 61

M The required solvents are connected and assigned. See Chapter 5.7 "Assigning
solvent to solvent lines", page 26

M The sample is prepared.
M The waste bottle is empty.

» Calibrate the solvent level sensor. See Chapter 5.8 "Calibrating the solvent level
sensor", page 27

» Calibrate the waste level sensor. See Chapter 5.12 "Calibrating the waste level

sensor", page 29

Open the protection shield.

» Place the fraction collection trays inside the instrument. See Chapter 6.4.5
“Inserting the fraction collection tray", page 60

» Close the protection shield.

Open an existing method. See Chapter 6.4.6 "Selecting an existing method",

page 61

Tap the button [OK].

Tap the button [Start] on the Run panel.

v

v

According the requirements adjust the file name.
Tap the button [OK].

vvyyvyy

= The display shows the dialog box Sampl/e Loading.

» According the requirements adjust the settings. See Chapter 6.4.7 "Selecting
values on the dialog box Sample Loading", page 61
» Follow the instructions on the display.
= Installing the cartridge. See Chapter 6.4.3 "Installing and removing a cartridge",
page 57
= Introducing the sample into the system. See Chapter 6.4.2 "Injecting a sample
into the flash system", page 55

6.5.4 Changings during a separation

d NOTE

Parameters that can be edited are highlighted in green
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Possibilities to edit the gradient during a separation:

® Change the gradient. See Chapter "Editing the gradient in graphic mode", page 47
® Hold the gradient. See Chapter 6.1.6 "Gradient panel”, page 39

® Auto gradient hold. See Chapter 6.1.6 "Gradient panel", page 39

6.5.5 Ending a Flash separation

d NOTE

The separation extends automatically by 5 minutes if the baseline at the end of the
separation is not below the set threshold.

Precondition:

M The display shows the dialog box Separation End.
» According to the requirements extend the separation time by 5 minutes.

Precondition:

M The display shows the dialog box Run completed.

» Follow the instructions on the display.

= Purging the instrument with air. See Chapter 7.8 "Removing solvent from an
used cartridge", page 78

= Removing the cartridge. See Chapter 6.4.3 "Installing and removing a cartridge",
page 57

6.5.6  Shutting down the instrument

Navigation path

- File

Precondition:

M The separation process has ended.

» Purge the instrument with purging solvent. See Chapter 7.6 "Cleaning the
instrument", page 77

» Navigate to the [File] menu via the navigation path.

» Tap the action [Shut down].

» Confirm the secure question with [Yes].

= The instrument is shutting down.

6.6 Performing a Flash separation manually

d NOTE
Pure C-810 / C-815 / C-850 only

6.6.1 Preparing the instrument

Time required: approx. 30 sec.

Precondition:

M All commissioning operations have been completed. See Chapter 5 "Installation",
page 24

» Switch the On/Off master switch to On.
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» Tap the On/Off switch.
= The instrument is starting up.
6.6.2 Selecting the flash mode (Pure C-850 only)

Navigation path

=> Mode

» Navigate to the Mode menu according to the navigation path.

» Select [Flash].

= The flash mode is selected.

6.6.3  Starting Flash separation manually

Precondition:

M The instrument is prepared. See Chapter 6.6.1 "Preparing the instrument",
page 63

M The required solvents are connected and assigned. See Chapter 5.7 "Assigning
solvent to solvent lines", page 26

M The sample is prepared.

M The waste bottle is empty.

» Calibrate the solvent level sensor. See Chapter 5.8 "Calibrating the solvent level
sensor", page 27

» Calibrate the waste level sensor. See Chapter 5.12 "Calibrating the waste level
sensor", page 29

» Open the protection shield.

» Place the fraction collection trays inside the instrument. See Chapter 6.4.5
"Inserting the fraction collection tray", page 60

» Close the protection shield.

» Select a cartridge. See Chapter 6.2.1 "Selecting a cartridge (Flash mode)", page 42

» Tap the drop-down list next to A: on the So/vent Selection panel.

= The display shows a drop-down list with the assigned solvents.

» Tap the required solvent.

= The solvent is selected

= The drop-down list closes.

» Select more solvents for the mobile phase according to your needs.

» Edit the gradient according to your needs. See Chapter 6.2.4 "Editing the
gradient", page 45

» Select the sample collection in the Col/lection panel. See Chapter 6.2.7 "Editing
the fraction collection criteria", page 49

» Select the collection criteria in the Collection criteria panel.

» Tap the button [Start] on the Run panel.

= The display shows the dialog box Sampl/e Loading.

» According the requirements adjust the settings. See Chapter 6.4.7 "Selecting
values on the dialog box Sample Loading", page 61
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» Follow the instructions on the display.

= Installing the cartridge. See Chapter 6.4.3 "Installing and removing a cartridge",
page 57

= Introducing the sample into the system. See Chapter 6.4.2 "Injecting a sample
into the flash system", page 55

6.6.4 Changings during a separation

d NOTE

Parameters that can be edited are highlighted in green

Possibilities to edit the gradient during a separation:

® Change the gradient. See Chapter "Editing the gradient in graphic mode", page 47
® Hold the gradient. See Chapter 6.1.6 "Gradient panel", page 39

® Auto gradient hold. See Chapter 6.1.6 "Gradient panel", page 39

6.6.5 Ending a Flash separation

d NOTE

The separation extends automatically by 5 minutes if the baseline at the end of the
separation is not below the set threshold.

Precondition:

M The display shows the dialog box Separation End.
» According to the requirements extend the separation time by 5 minutes.

Precondition:

M The display shows the dialog box Run completed.

» Follow the instructions on the display.

= Purging the instrument with air. See Chapter 7.8 "Removing solvent from an
used cartridge", page 78

= Removing the cartridge. See Chapter 6.4.3 "Installing and removing a cartridge",
page 57

6.6.6  Shutting down the instrument

Navigation path

= File

Precondition:
M The separation process has ended.

» Purge the instrument with purging solvent. See Chapter 7.6 "Cleaning the
instrument", page 77

» Navigate to the [File] menu via the navigation path.

» Tap the action [Shut down].

» Confirm the secure question with [Yes].

= The instrument is shutting down.
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6.7

6.7.1

6.7.2

6.7.3

Performing a Prep separation using a method

NOTE
Pure C-830 / C-835 / C-850 only

Preparing the instrument

Time required: approx. 30 sec.

Precondition:

M All commissioning operations have been completed. See Chapter 5 "Installation",
page 24

» Switch the On/Off master switch to On.

» Tap the On/Off switch.

= The instrument is starting up.

Selecting the prep mode (Pure C-850 only)

Navigation path

- Mode

» Navigate to the Mode menu according to the navigation path.
» Select [Preparative].
= The prep mode is selected.

Starting a Prep separation using a method

Precondition:

M The instrument is prepared. See Chapter 6.7.1 "Preparing the instrument",
page 66

M The required solvents are connected and assigned. See Chapter 5.7 "Assigning
solvent to solvent lines", page 26

M The sample is prepared.
M The waste bottle is empty.

» Calibrate the solvent level sensor. See Chapter 5.8 "Calibrating the solvent level
sensor", page 27

» Calibrate the waste level sensor. See Chapter 5.12 "Calibrating the waste level

sensor", page 29

Open the protection shield.

» Place the fraction collection trays inside the instrument. See Chapter 6.4.5
“Inserting the fraction collection tray", page 60

» Close the protection shield.

Open an existing method. See Chapter 6.4.6 "Selecting an existing method",

page 61

Tap the button [OK].

Tap the button [Start] on the Run panel.

v

v

According the requirements adjust the file name.
Tap the button [OK].

vvyyvyy

= The display shows the dialog box Sampl/e Loading.
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6.7.4

6.7.5

6.7.6

6.8

» According the requirements adjust the settings. See Chapter 6.4.7 "Selecting
values on the dialog box Sample Loading", page 61
» Follow the instructions on the display.

= Installing the column. See Chapter 6.4.4 "Installing and removing a column",
page 58

= Introducing the sample into the system. See Chapter 6.4.1 "Introducing a sample
into the prep system", page 54

Changings during a separation

NOTE

Parameters that can be edited are highlighted in green

Possibilities to edit the gradient during a separation:

® Change the gradient. See Chapter "Editing the gradient in graphic mode", page 47
® Hold the gradient. See Chapter 6.1.6 "Gradient panel", page 39

® Auto gradient hold. See Chapter 6.1.6 "Gradient panel", page 39

Ending a Prep separation

NOTE

The separation extends automatically by 5 minutes if the baseline at the end of the
separation is not below the set threshold.

Precondition:

M The display shows the dialog box Separation End.

» According to the requirements extend the separation time by 5 minutes.

Shutting down the instrument

Navigation path

-> File

Precondition:

] The separation process has ended.

» Removing the column. See Chapter 6.4.4 "Installing and removing a column",
page 58

» Purge the instrument with purging solvent. See Chapter 7.6 "Cleaning the
instrument", page 77

» Navigate to the [File] menu via the navigation path.

» Tap the action [Shut down].

» Confirm the secure question with [Yes].

= The instrument is shutting down.

Performing a Prep separation manually

NOTE
Pure C-830 / C-835 / C-850 only
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6.8.1 Preparing the instrument

Time required: approx. 30 sec.

Precondition:

M All commissioning operations have been completed. See Chapter 5 "Installation",
page 24

» Switch the On/Off master switch to On.

» Tap the On/Off switch.

= The instrument is starting up.

6.8.2 Selecting the prep mode (Pure C-850 only)

Navigation path

- Mode

» Navigate to the Mode menu according to the navigation path.
» Select [Preparative].

= The prep mode is selected.

6.8.3  Starting a separation

Precondition:

M The instrument is prepared. See Chapter 6.8.1 "Preparing the instrument",
page 68

M The required solvents are connected and assigned. See Chapter 5.7 "Assigning
solvent to solvent lines", page 26

M The sample is prepared.

M The waste bottle is empty.

» Calibrate the solvent level sensor. See Chapter 5.8 "Calibrating the solvent level
sensor", page 27

» Calibrate the waste level sensor. See Chapter 5.12 "Calibrating the waste level
sensor", page 29

» Open the protection shield.

» Place the fraction collection trays inside the instrument. See Chapter 6.4.5
“Inserting the fraction collection tray", page 60

» Close the protection shield.

» Install a column. See Chapter 6.4.4 "Installing and removing a column", page 58

» Tap the drop-down list next to A: on the So/vent Selection panel.

= The display shows a drop-down list with the assigned solvents.
» Tap the required solvent.

= The solvent is selected

= The drop-down list closes.

» Select more solvents for the mobile phase according to your needs.
» Edit the gradient according to your needs. See Chapter 6.2.4 "Editing the
gradient", page 45

» Enter the required times in the Conditions panel.
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6.8.4

6.8.5

6.8.6

» Select the sample collection in the Collection panel. See Chapter 6.2.7 "Editing
the fraction collection criteria", page 49

» Select the collection criteria in the Collection criteria panel.

» Tap the button [Start] on the Run panel.

= The display shows the dialog box Sampl/e Loading.
= The instrument starts the separation.

» According the requirements adjust the settings. See Chapter 6.4.7 "Selecting
values on the dialog box Sample Loading", page 61
» Follow the instructions on the display.

= Installing the column. See Chapter 6.4.4 "Installing and removing a column",
page 58

= Introducing the sample into the system. See Chapter 6.4.1 "Introducing a sample
into the prep system", page 54

Changings during a separation

NOTE

Parameters that can be edited are highlighted in green

Possibilities to edit the gradient during a separation:

® Change the gradient. See Chapter "Editing the gradient in graphic mode", page 47
® Hold the gradient. See Chapter 6.1.6 "Gradient panel", page 39

® Auto gradient hold. See Chapter 6.1.6 "Gradient panel", page 39

Ending a Prep separation

NOTE

The separation extends automatically by 5 minutes if the baseline at the end of the
separation is not below the set threshold.

Precondition:
M The display shows the dialog box Separation End.

» According to the requirements extend the separation time by 5 minutes.

Shutting down the instrument

Navigation path

= File

Precondition:
VI The separation process has ended.

» Removing the column. See Chapter 6.4.4 "Installing and removing a column",
page 58

» Purge the instrument with purging solvent. See Chapter 7.6 "Cleaning the

instrument", page 77

Navigate to the [File] menu via the navigation path.

» Tap the action [Shut down].

v
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» Confirm the secure question with [Yes].

= The instrument is shutting down.

6.9 Identifying fractions
6.9.1 Identifying fractions by peak

1-4365 0-724%

| .

g b B

Fig. 9: Identifying fractions

Navigation path

=> Gradient panel

Precondition:
M A separation is finished.

» Navigate to the Gradient panel according the navigation path.
» Tap the peak with the target value.

= The Collection panel shows the corresponding vial.
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6.9.2

6.10
6.10.1

Identifying fractions per vial
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Fig. 10: Identifying fractions

Navigation path

=> Collection panel

Precondition:
M A separation is finished.

» Navigate to the Collection panel according the navigation path.
» Tap the target vial.

= The Gradient panel shows the corresponding peak.
Importing and exporting data

Printing a run report

Navigation path

=> File => Print Run Report

Precondition:
M The instrument is in past run mode.

» Navigate to the Print Run Report dialog according to the navigation path.

= The display shows the Windows® print dialog.

» Select your printer.
» Tap the button [OK].

= The report is printed.
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6.10.2

6.10.3

Sending data to USB

Navigation path

=> Run panel

Precondition:
M The instrument is in past run mode.

» Connect a USB storage device to the instrument.

» Navigate to the Run panel according the navigation path.

» Tap the button [Data to USB].

= The instrument saves an Excel file to the USB storage device.
» Confirm the complete message.

= The data is stored.

Sending PDF to USB

Navigation path

=> Run panel

Precondition:
M The instrument is in past run mode.

» Connect a USB storage device to the instrument.

» Navigate to the Run panel according the navigation path.
» Tap the button [PDF to USB].

= The instrument saves a PDF file to the USB storage device.
» Confirm the complete message.

= The data is saved.
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7 Cleaning and servicing

d NOTE

Users may only carry out the servicing and cleaning operations described in this
section.

Any servicing and repair work which involves opening up the casing may only be
carried out by BUCHI service technicians.

» Use only genuine BUCHI consumables and spare parts in order to ensure correct
operation of the device and preserve the warranty.

7.1 Regular maintenance work
Component Action Frequency
Pumps and valves  » Purge the instrument with air. See Daily

Chapter 7.8 "Removing solvent from an
used cartridge", page 78

» Purge the instrument with purging
solvent. See Chapter 7.6 "Cleaning the
instrument", page 77

Tubing » Check for leaks. If a leak is observed,  Daily
resolve the issue before continuing.

Fittings » Inspect fittings; if solid material is Daily
deposited on a fitting, clean and
tighten (replace) the fitting before
continuing.

Drain lines » Check all drain lines to ensure that Daily
liquid can flow through them to the
waste container

Waste bottle » Empty the waste bottle Daily

Filters » Check the filters in the solvent bottles Weekly
and clean if necessary.

Fittings » Check and if necessary tighten the Weekly
fitting that secures the tubing from the
mobile phase reservoir manifold to the
inlet check valve housing

Data » Perform a data backup Weekly
Casing » Wipe down the casing with a damp Weekly
cloth.
» If heavily soiled, use ethanol or a mild
detergent.

Warning symbols  » Check that the warning symbols on the Weekly
instrument are legible.
» If they are dirty, clean them.

Display » Wipe down the display with a damp Monthly
cloth.
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7.2

7.3

Component Action Frequency

Nebulizer » Clean the nebulizer. See Chapter 7.4  Monthly
"Cleaning the nebulizer", page 75

Air filter » Replace the air filter. Yearly

Sample injection » Check if the valve is tight, if necessary Yearly

valve replace the sealing.

Shuttle valve » Check if the valve is tight, if necessary Yearly

replace the sealing.

Carrying out a data backup

O
<

L)

Navigation path

- File = Exit

» Navigate to the Exi/t dialog according to the navigation path.
» Confirm the secure question.

= The Pure software is shutting down.

= The display shows a Windows® system.

» Connect a USB storage device to the instrument.

» Open the Windows® Explorer.

» Navigate to the data you wish to backup. See Chapter 10.2 "Folder locations",
page 97

» Copy the needed data to the USB storage devices.

Calibrating the display

Navigation path

=> Tools = Calibration and Defaults

» Navigate to the Calibration and Defaults dialog according to the navigation
path.
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» Tap the button [Calibrate].
» Follow the instructions on the display.

7.4 Cleaning the nebulizer
Materials Needed:
® HPLC-grade 50:50 methanol: water solution

® Sonication bath

» Switch the On/Off master switch to Off.

» Disconnect the liquid inlet line from the
nebulizer.
» Disconnect the gas inlet from the nebulizer

» Remove the knurled screws.

» Remove the nebulizer from the drift tube.

» Place the nebulizer in a beaker filled with 50:50
methanol: water solution.

» Sonicate the nebulizer in an ultrasonic bath for
10 minutes.

» If the nebulizer is still completely blocked,
connect a high-pressure air line to the nebulizer
inlet to help remove the blockage.

» If the nebulizer cannot be cleaned, replace the
nebulizer.
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» Replace the nebulizer wear band.

» Place the nebulizer to the thrift tube.

» Attach the knurled screws.

» Connect the liquid and gas inlet lines to the
nebulizer.

7.5 Cleaning the check valve

d NOTE

1 Most check valve problems can be solved by pumping a strong solution of liquid
laboratory grade detergent through the check valves at a rate of 20 mL/min for one

hour.

Pumping detergent through the check valves
Materials needed:

® Liquid Laboratory Detergent

® |sopropanol/Water (50/50) or Methanol/Water (50/50)
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Navigation path

=> Tools => Manual Control = Column Flushing...

Precondition:
M A bypass is installed. See Chapter 6.4.4 "Installing and removing a column",
page 58

» Navigate to the Column Flushing dialog according to the navigation path.

Sonicate the check valve

Materials needed:

® QOpen-end wrench, %”, 9/16" x 5/16"
® Torque wrench

» Switch the On/Off master switch to Off.

» Disconnect the mobile phase tubing from the inlet (bottom) of the pump head
using the 9/16” open-end wrench.

» Disconnect the mobile phase outlet tubing from the top of the pump head using
the 5/16” open end wrench.

» Remove both check valve housings from the pump head using the %5” open-end
wrench.

= The check valve capsule is accessible.

» Sonicating the check valve for 10 min in the appropriate solvent.

» Install the check valve.

» Install the check valve housings back into the pump head.

» Tighten the check valve housing to 75 inch pounds with the %" torque wrench.

7.6 Cleaning the instrument

L]

[

Navigation path

=> Tools => Manual Control => Column Flushing...

Precondition:
M A purging solvent is assigned to the instrument. See Chapter 5.7 "Assigning
solvent to solvent lines", page 26

» Install a bypass. See Chapter 6.4.4 "Installing and removing a column", page 58
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» Navigate to the Co/lumn Flushing dialog according to the navigation path.

» Enter the required data according to your needs.

7.7 Cleaning the solid loader

Navigation path

=> Tools => Manual Control = Solid Loader Flushing...

» Install a bypass. See Chapter 6.4.4 "Installing and removing a column", page 58
» Navigate to the Solid Loader Flushing dialog according to the navigation
path.

7.8 Removing solvent from an used cartridge

—
1

[

Navigation path

=> Tools => Manual Control = Air Purging

Precondition:
M The cartridge is installed.
» Navigate to the Air Purging dialog according to the navigation path.

» Enter the purging time according to your needs.
» Tap the button [Column purge].

= The instrument and the cartridges are cleaned.
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8 Help with faults

8.1 Faults, possible causes and solutions (general)
Malfunction Possible cause Solution
The instrument Power is not being supplied to » Verify that the power cord is
does not power up the system plugged in.

» Make sure that the voltage,
amperage and frequency
meet the instrument
specifications.

» Make sure that both power
switches are switched on.

» Verify that the fuse wire is
not broken and fuses are
correctly installed in the
instrument.

System shuts down Major fluctuations in line » Connect system to a
automatically power are present Uninterrupted Power Supply
line.

The touch screenis The touch screen is out of cali- » Recalibrate the touch
not responsive bration screen.

8.2 Faults, possible causes and solutions (cartridge)

Malfunction Possible cause Solution

Cartridge is not de- RFID tag is not facing the RFID » Turn cartridge so that RFID

tected reader tag faces RFID reader.
RFID tag is bad » Use new cartridge.
8.3 Faults, possible causes and solutions (solvent delivery)
Malfunction Possible cause Solution
No solvent flow Empty solvent bottle » Refill the solvent bottle.
Pump not primed » Prime the pump.

» Remove the check valve and
clean it by sonicating the
check valve in IPA.

» If sonication does not work
replace the check valve with
a new check valve.

Air bubbles in solvent line » Prime the pump.

Pump seals worn out » Replace the pump seals.
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Malfunction Possible cause Solution

Pulsation of pump  Open or close time of the inlet » Rinse the pump module with
or outlet valves are not correct  high flowrate with ethanol
Residues in solvent or hot distilled water.

» Change check valves.

Sealing abrasion outlet valve

Inconsistent solvent Loose fitting/air leak into the  » Find the loose fitting

flow pump between mobile phase
reservoir manifold and
pump inlet fitting and

tighten it up.
Liquid leak/pump seals worn  » Fix the leak/replace the
out pump seals.
Pump head temperature » Premix the solvents to
reaches solvent boiling tem- reduce solvent volatility.

perature, causing the pump to » Place the highly volatile
lose prime and stop flow (this solvent bottle in an ice bath
is likely to occur when running  to eliminate boiling.
methods with highly volatile

solvents such as diethyl ether

and methylene chloride)

System pump pres- Blocked solvent lines » Find the blocked lines and
sure is higher than replace it.
expected Over-tightened fitting » Loosen the fitting or replace
it.
Blocked columns or fluidic » Locate the component that
path caused the blockage, repair,

or replace the component.

Leaks Fitting connection not tight » Find the loose fitting and
tighten it up.
Damaged solvent line » Find the damaged solvent

line and replace it.

Pump not running  Pump sensor cable becomes  » Locate the cable and
disconnected reconnect to the pump
sensor.

Pump power cable becomes  » Locate the power cable and
disconnected reconnect to the main board
or to the pump.

Incorrect flow path Incorrect fluidic connections  » Check/correct the fluidic
to/from the mode switching connections.
valve
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8.4 Faults, possible causes and solutions (sample injection)

Malfunction

Possible cause Solution

Leak around the in-
jection port
(Flash mode)

Dried sample or particulate » Clean the injection port with
matter interferes with syringe appropriate solvent or
fitting remove particulate matter.

Defective injection port (Luer » Replace the injection port.
fitting) adapter

Solid loader leaking

Loader hardware is not prop- » Verify that the loader

erly set up hardware is set up correctly.
Leak around the Loose fitting » Find the loose fitting and
prep injection tighten it up.
valve/sample loop
8.5 Faults, possible causes and solutions (fraction collection)
Malfunction Possible cause Solution

Liquid not being col-

Incorrect fraction collection » Verify that fraction

lected in fraction settings collection information is set
tubes properly.

Liquid not centered Fraction collector is not cali- ~ » Recalibrate the fraction

in fraction tube brated collector.

Fraction collector
(FC) arm does not
move

Fraction collector arm did not » Reset the Fraction collector
home properly arm.

Fraction collector arm motor is » Tighten the motor coupler.
slipping

Fraction collector arm is ob-  » Check for cable or burr in

structed the fraction collector arm
path and remove any
obstruction.

Tray not detected

RFID tag is bad » Put another tray into the
same position to see if it is
recognized to confirm the
cause.

» Replace RFID tag.
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8.6

Faults, possible causes and solutions (detection)

Malfunction Possible cause Solution
ELSD signal is low or Sample is too volatile » Sample cannot be detected
disappears by ELSD due to its volatility.

No or low ELSD carrier gas flow » Verify there is gas supplied

to the instrument.

» Check for leak in the gas
lines.

» Verify that there is gas flow
to the nebulizer from the
ELSD sampling valve.

» Verify that there is gas flow
to the ELSD sampling valve.

Sample stuck on column » Use stronger solvent or
change column chemistry.

ELSD not equilibrated long » Restart run to re-stabilize
enough and rezero ELSD baseline.

Blocked nebulizer » Sonicate nebulizer to clean
or replace the nebulizer.

Blocked ELSD line » Trace the blockage and
replace the blocked line.

Rotor and/or stator in ELSD » Replace the rotor and/or

Sampling valve is worn, dirty, stator.

or clogged
Poor ELSD Peak Blocked nebulizer or nebulizer » Clean the nebulizer or
shape tubing replace the nebulizer tubing.

Nebulizer tubing is not prop-  » Reinstall the nebulizer
erly connected tubing properly.
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8.7

Malfunction

Possible cause

Solution

Noisy ELSD baseline

Dirty or contaminated gas

» Replace gas source.
» Replace filter.

Gas is not dry/high humidity
environment

» Use a dry air supply.
» Use nitrogen.

Moisture trapped in the gas
lines

» Remove moisture from lines
by purging the air flow
system with nitrogen for 5
minutes.

Mobile phase is contaminated
or contains non-volatile modi-
fiers

» Use volatile modifiers in the
mobile phase.

Solvent contains non volatile
stabilizers

» Use solvent with volatile
modifiers.

Dirty optics

» Clean the optics.

Dirty drift tube

» Clean drift tube.

Not correct installed exhaust

» Install the exhaust correctly.
See Chapter 5.9 "Installing
the exhaust (ELSD only)",
page 28

Electronics - Preamp not
grounded properly

» Verify that preamp
grounding cable is in place.

Nebulizer is partially blocked

» Sonicate nebulizer to clean
or replace.

Silica or packing material
leaked out of cartridge

» Replace the cartridge.
» Flush the system.

No UV signal

UV light burned out

» Replace the UV light.

Low UV signal

Dirty flow cell

» Clean the flow cell.

Error messages

Error message

Possible cause

Solution

Instrument Alarm:
Solvent pump: Com-
munication to the
pump cannot be es-
tablished.

Serial communication dis-
turbed

» Restart the instrument.

Instrument Alarm:
Solvent pump: Mo-
tor overloading.

» Contact BUCHI Customer
Service.

Instrument Alarm:
Solvent pump: Mo-
tor regulation error.

Hardware error solvent pump

» Contact BUCHI Customer
Service.
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Error message

Possible cause

Solution

Instrument Alarm:
Solvent pump:
Power supply error.

Hardware error solvent pump

» Contact BUCHI Customer
Service.

Instrument Alarm:
Solvent pump: Sol-
vent pump motor

fan is not working.

Hardware error fan solvent
pump

» Contact BUCHI Customer
Service.

Instrument Alarm:
UV detector: Com-
munication error
occurred.

Serial communication dis-
turbed

» Restart the instrument.

Instrument Alarm:
UV detector: Bad
block of High Volt-
age (HV) generator
for lamp or discon-
nected lamp or bad
lamp.

Lamp defect

No lamp

Hardware error UV detector

» Check the lamp and restart
instrument.

» Contact BUCHI Customer
Service.

Instrument Alarm:
UV detector: Bad
power supply of
lamp heater volt-
age.

Hardware error UV detector

» Contact BUCHI Customer
Service.

Instrument Alarm:
UV detector: Bad
power supply of
lamp anodic volt-
age.

Hardware error UV detector

» Contact BUCHI Customer
Service.

Instrument Alarm:
UV detector: Bad
power supply of de-
tector analog or dig-
ital voltage.

Hardware error UV detector

» Contact BUCHI Customer
Service.

Instrument Alarm:
UV detector: 4th cy-
cle of lamp ignition
fails.

Lamp defect

» Check the lamp and restart
instrument.

Instrument Alarm:
UV detector: Lamp
spontaneously
douse during unit
working.

Lamp defect

» Check the lamp and restart
instrument.
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Error message Possible cause Solution

Instrument Alarm: Hardware error UV detector. » Contact BUCHI Customer
UV detector: Lamp Service.

ignition fails after

short douse in AU-

TOZERO function

and repeated High

Voltage impulse and

heater cycle fails

too.

Instrument Alarm:  Lamp defective/ Flow cell dirty » Check the lamp and restart
UV detector: Bad instrument.

identification of

light peak caused by

low light intensity.

Instrument Alarm: Lamp defective/ Flow cell dirty » Check the lamp and restart
UV detector: Bad instrument.

identification of

light peak caused by

unworkable light in-

tensity.

Instrument Alarm: Hardware error UV detector  » Contact BUCHI Customer
UV detector: Low Service.

light intensity was

found on some

photo elements of

CCD sensor.

Instrument Alarm: Hardware error UV detector  » Contact BUCHI Customer
UV detector: Spon- Service.

taneously failure on

analog or digital

power supply.

Instrument Alarm:  Hardware error UV detector  » Contact BUCHI Customer
UV detector: Error Service.

or base offset of

unit, bad CCD sen-

sor, monochroma-

tor is open.
Instrument Alarm:  2nd lamp defect » Check the lamp and restart
UV detector: Sec- instrument.

ondary lamp is not
working or lamp
spontaneously
douse.
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Error message Possible cause

Solution

Instrument Alarm:
UV detector: Any
fan is not working or
any fan is discon-
nected or mechani-
cal blocked.

Hardware error UV detector

» Contact BUCHI Customer
Service.

Solvent List File Solvent list file corrupted

» Shutdown the Pure
software.

» Delete the solvent list.

» Restart the Pure software.

Solvent Lines File:
Invalid program ex-

Solvent lines file corrupted

ecution.

» Shutdown the Pure
software.

» Delete the solvent list.

» Restart the Pure software.

Solvent Defaults
File: The solvent in-
formation file and
the default solvent
information file are
missing.

Software damaged

» Uninstall and reinstall
software.

Using Default Sol-
vent List: System
defaults used in-
stead of actual re-
source.

Solvent file has been deleted

» Restart the instrument.

Solvent Pressure:
Pressure limit has
been exceeded.

Blockage in the line

» Remove column.

» Replace with bypass.

» Determine if column is not
the source of blockage.

» If not column is the source
of blockage, then check all
fluidic lines.

Sample crashing/precipitate

» Purge lines/system with a
strong or appropriate
solvent that will dissolve the
sample

Valve stuck in incorrect posi-

tion

» Reset valve position.
» Contact BUCHI Customer
Service.
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Error message

Possible cause

Solution

Solvent Pressure 2:
Pressure limit has
been exceeded.

Blockage in line after the ELSD
sampling valve

» Check the fluidic lines and
components downstream
from the pressure sensor 2
(between the ELSD sampling
valve and the fraction
collector valve, waste line)
for the source of blockage.

Error in solvent line
calibration file.

Calibration file of solvent lines
damaged

» Shutdown the Pure
software.

» Delete the calibration list.

» Restart the Pure software.

Inlet Gas Pressure
Out of Range - LOW
PRESSURE

No gas or gas flow is low

» Check the gas lines in the
system for leaks.

» Make sure gas source/tank
is available.

The pressure gauge is not set
correctly

» Check pressure gauge
setting to make sure that it
is set to deliver 2.5 L/min
gas flow (Inlet Pressure with
Air State off around 85 - 115

psi).

Inlet Gas Pressure
Out of Range - LOW
PRESSURE (Before
run starts)

Blockage in the system

» Check the gas lines in the
system for blockages.

The pressure gauge is not set
correctly

» Check pressure gauge
setting to make sure that it
is set to deliver 2.5 L/min
gas flow (Inlet Pressure with
Air State off around 85 - 115

psi).

Inlet gas pressure
out of range- HIGH
(During run)

Blockage in the nebulizer or
gas line to the nebulizer

» Check the nebulizer or
tubing to the nebulizer for
blockages

» Sonicate the nebulizerin a
suitable solvent or replace
nebulizer

Sensor pressure cal-
ibration file

Pressure sensor calibration file
damaged.

» Shutdown the Pure
software.

» Delete the pressure value
list.

» Restart the Pure software.
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Error message

Possible cause

Solution

Instrument Alarm:
Vapor

Vapor sensor settings are set
too sensitive

» Change the vapor limits to a
lower sensitivity. See
Chapter 6.2.9 "Editing the
vapor sensor sensitivity",
page 52

Leaks

» Check for any leaks in the
solvent flow paths.

Solvent vapors in work area

» Solvent vapors in the work
area may set on the alarm.
Use the instrumentin a
hood or well ventilated area
with no open solvents near
the system.

Vapor sensor no sig-
nal

Vapor sensor is not connected
or is defect

» Check the cable to the vapor
sensor.

Instrument Alarm:
Watchdog

Timing/communication issue
in software

If in setup mode:

» Restart the instrument.

4

If in run mode:

» Press reset.

» Restart after the run is
finish.

Solvent Pressure

Solvent pressure limit has
been exceeded

» Remove column.

» Replace with bypass.

» Determine if column is not
the source of blockage.

» If not column is the source
of blockage, then check all
fluidic lines.
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8.8

Error message

Possible cause

Solution

Fraction Collector

Arm is obstructed

» Check arm path to make
sure there are no
obstructions.

» Reset the Fraction Collector
arm. See Chapter 8.8
"Resetting the Fraction
collector arm", page 89

Fraction collector arm did not
home properly

» Tighten the motor coupler.
» Contact BUCHI Customer
Service.

Fraction collector arm motor is

slipping

» Contact BUCHI Customer
Service.

Home position sensor is bad

» Contact BUCHI Customer
Service.

Fraction collector arm motor
has no power

» Contact BUCHI Customer
Service.

Mode Switching
Valve Failure

The Mode Switching valve
failed to switch.

» Press Reset button to stop
the alarm.

» Contact BUCHI Customer
Service.

Prep Injection Valve
Failure

Prep Injection Valve failed to
switch.

Only Flash mode runs can be

performed.

» Press Reset button to stop
the alarm.

» Contact BUCHI Customer
Service.

Low Disk Space

The disk space on this unit is
almost full.

» Back up and delete data.
» Contact BUCHI Customer
Service.

Solvent Safety Sen-
sor alert

More solvent required

» Add solvent to bottle.

Solvent safety sensor was not
calibrated

» Calibrate/zero the solvent
safety sensor properly.

Waste Safety Sensor Waste container is full

alert

» Empty waste container.

Waste safety sensor was not
calibrated

» Calibrate/zero the solvent
safety sensor properly.

Resetting the Fraction collector arm

Navigation path

= Tools = Manual Control = Fraction Collector Arm Reset

» Navigate to the Fraction Collector Arm Reset dialog according to the

navigation path.
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8.9

» Confirm the secure question.

= The Fraction collector arm is resetted.

Replacing the shuttle valve rotor
Materials needed:
® Torx wrench T10

® Pure sampling valve kit

» Switch the On/Off master switch to Off.

Precondition:

I Make sure that all tubings are marked for later

installation.

» Remove all tubings.

» Loosen the screws with the Torx wrench.

» Remove the valve head.

» Remove the valve rotor.
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» Make sure that the holes in the new rotor and
the pins inside the valve match.

» Attache the valve head to the instrument with
Screws.

» Attach all tubings to the instrument.
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9.1

9.2

9.3

Taking out of service and disposal

Taking out of service

» Switch off the instrument and disconnect it from the mains power supply.
» Remove all tubing and communication cables from the device.

Disposal

The operator is responsible for proper disposal of the instrument.

» When disposing of equipment observe the local regulations and statutory
requirements regarding waste disposal.

» When disposing, observe the disposal regulations of the materials used. Materials
used see Chapter 3.5 "Technical data", page 18

Returning the instrument

Before returning the instrument, contact the BUCHI Labortechnik AG Service
Department.
https://www.buchi.com/contact
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10 Appendix

10.1 Spare parts and accessories

Use only genuine BUCHI consumables and spare parts in order to ensure correct,
safe and reliable operation of the system.

d NOTE

Any modifications of spare parts or assemblies are only allowed with the prior
written permission of BUCHI.

10.1.1 Accessories

Order no.
Pure rack type 1 11066672
Rack for 12 x 75 mm glass tubes, 1 pc.
Pure rack type 2 11066673
Rack for 13 x 100 mm glass tubes, 1 pc.
Pure rack type 3 11066674
Rack for 16 x 125 mm glass tubes, 1 pc.
Pure rack type 4 11066675
Rack for 16 x 150 mm glass tubes, 1 pc.
Pure rack type 5 11066676
Rack for 18 x 150 mm glass tubes, 1 pc.
Pure rack type 6 11066677
Rack for 25 x 150 mm glass tubes, 1 pc.
Pure rack type 7 11068452
Rack for 9 squared bottles of 480 mL, 1 pc.
Pure rack type 8 (funnel rack) 11069407
Rack for 6 funnels
Pure rack type 9 11069242

Rack for 16 x 100 mm glass tubes, 1 pc.
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Order no. Image
Solvent bottle platform kit 11069285

Solvent bottle platform on top of the instrument. For maxi-
mum 4 bottles (volume 4 L each)

Retaining container 11068468

Retaining container for solvent bottle platform for more
safety regarding leaking

Pure Dry Air Supply unit 11069026
Loading Pump 11071418
with flow rates from 2.5 to 250 mL/min, incl. tubing and fit-

ting

Pure cartridge holder XXL 11070532

Cartridge holder for cartridges of 800 g to 5000 g

Pure column holder XL 11068467 @

Column holder for column diameters 50 to 70 mm .
Pure nebulizer set 11069464 @

10.1.2 Sample introduction accessories

o),

Order no.

Pure Solid loader S set, incl. adapter set, sleeve, tubes (20 pcs.) and 11068975
frits (40 pcs.)

Pure Solid loader M set, incl. adapter set, sleeve, tubes (20 pcs.) and 11070505
frits (40 pcs.)

Pure Solid loader frits S (40 pcs.) 11068969
Pure Solid loader frits M (40 pcs.) 11069654
Pure Solid loader tubes S (20 pcs.) 11068971
Pure Solid loader tubes M (20 pcs.) 11069653
Pure Solid loader insertion rod S (1 pc.) 11068973
Pure Solid loader insertion rod M (1 pc.) 11070569
Male union 1/4"-28 sl 11070416
Pure sample loop 2 ml, 1 pc. 11068476
Pure sample loop 5 ml, 1 pc. 11068205
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Order no.
Pure sample loop 10 ml, 1 pc. 11068206
10.1.3 Spare parts
Order no. Image

Pure cartridge holder 11065940 @
Cartridge holder for cartridges for 4 gto 330 g >

&
Pure column holder 11066594 %g
Column holder for columns diameters 10mm to 50mm

=
Injection valve UNF 1/4"-28 044867
Pure transfer line ELSD 11069409 m
Touch-screen stylus 11068360 /
Sample injection & mode valve stator 11069688

%
O
10.1.4 Tubes
Order no.
Pure Glass Tubes 13 x 100 mm 148623414
1000 pcs.
Pure Glass Tubes 16 x 150 mm 148623416
1000 pcs.
Pure Glass Tubes 18 x 150 mm 148623410
500 pcs.
Pure Glass Tubes 25 x 150 mm 148623411
500 pcs.
Pure Squared bottles 480 mL 148623412
24 pcs.
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10.1.5 Tools and adapter kits

Order no.

Luer lock connection set 11068242
Set of 2 luer lock adapters
Advanced adapter kit flash 11068361

Tube cutter, Fittings (1/8", 1/16"), Tubing (pneumatic, FEP 1/8", FEP 1/16"), Luer
Lock adapters, Pneumatic reduction, Fuses, Injection valve

Advanced adapter kit prep 11068362
Wrenches, Fittings (1/8", 1/16"), One piece fitting, 1/16", Tubing (pneumatic, FEP

1/8", PEEK 1/16"), SS nut and ferrule, Reductions, Fuses

Advanced adapter kit flash/prep 11068363

Tube cutter, Wrenches, Fittings (1/8", 1/16"), One piece fitting, 1/16", Tubing
(pneumatic, FEP 1/8", FEP PEEK 1/16"), SS nut and ferrule, Reductions, Luer Lock
adapters, Fuses, Injection valve

Pure solvent line kit 11068215

Package with 4 solvent lines and 5 level sensing lines

Kit Steel Tubing Prep units 11070081

To replace the PEEK tubing with stainless steel tubing (for Prep instruments)

10.1.6 Wear parts

Order no.
Pure air filter 11066049
O-Ring for Pure nebulizer 11066421
Pure nebulizer 11066423
Pure UV flow cell 0.3 mm 11068210
For all C-8xx
Pure UV flow cell 1.3 mm 11068214
For all C-8xx, for enhanced sensitivity
Shuttle valve rotor & head 11068229
Hose SV-ELSD cpl. 11069457
Pure Solid loader test 20 pcs 11069686
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10.2 Folder locations

Explanation Type Folder

Method files .efm  C:\Users\Public\Documents\Buchi\Pure\meth-
ods

Run files .gkfr  C:\Users\Public\Documents\Buchi\Pure\runs

10.3 Finding out separation conditions with the navigator

10.3.1 Open the navigator

Navigation path

=> Gradient panel

» Navigate to the Gradient panel according the navigation path.
» Tap the button [Navigator].

= The display shows the dialog Navigator.

10.3.2 TLCSSilica
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The TLC-Silica tool uses TLC separation data to provide a recommended gradient for
silica separations of 2 or 3 components.
Specification of the samples needed:

e Two different solvent concentrations
® Two separations

® Silica TLC plates
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Precondition:
M The display shows the dialog Navigator. See Chapter 10.3.1 "Open the
navigator", page 97

Select the TLC- Silica tab.

Select the radio button for two or three components.

Select the weaker solvent at drop-down list A.

Select the stronger solvent at drop-down list B.

Enter the solvent B concentrations used in the TLC separations.
Measure the distance the spot moved on the silica TLC plates.
Divide the measured value by the distance the solvent traveled.

vvvyvVvyVvyVvyy

= This is your Rf- value.

» Enter the value in the Rf entry field.
» Select the column you wish to use from the drop-down list

= The column is selected.
= The display shows the default flow rate.

» Adjust the flow rate according to your needs.
» Select the radio button for Speed or Purity.
» Tap the button [Calculate].

= The display shows the results.

» Adjust the following values if necessary:
® Column

® Flow rate

® Speed / Purity

» Tap the button [Accept].

= The gradient is saved for a run.
= The dialog box closes.

98/102 Operation Manual Pure Chromatography Instruments



Blichi Labortechnik AG

Appendix | 10

10.3.3 LC-C18
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The LC-C18 Tool uses isocratic HPLC separation data to provide a recommended

gradient for reversed phase separations of 2 components.
Specification of the samples needed:

® Two isocratic runs on a HPLC column
e Different mobile phase solvent concentrations

® Retention times (t1 and t2) of the components from the chromatograms.

Precondition:
M The display shows the dialog Navigator. See Chapter 10.3.1 "Open the

navigator", page 97

Select the LC-C 18 tab.

Select the HPLC column used from the drop-down list.

Select the weaker solvent at drop-down list A.

Select the stronger solvent at drop-down list B.

Enter the solvent concentrations used in the HPLC separations.

vVvVvyvVvyVvyyvVvyy

Select the column you wish to use from the drop-down list
= The column is selected.
= The display shows the default flow rate.

» Adjust the flow rate according to your needs.
» Select the radio button for Speed or Purity.
» Tap the button [Calculate].

= The display shows the results.

Enter the retention times for each separation under each chromatograph.
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Tap the button [Accept].

= The gradient is saved for a run.

= The dialog box closes.

10.3.4 LC-Transfer
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The LC-Transfer tool converts an HPLC gradient into a Flash Chromatography
gradient.
Specification of the sample needed:

One run on a HPLC column (in gradient elution mode)

Times %B changes (t1, t2 and t3)

Precondition:

M The display shows the dialog Navigator. See Chapter 10.3.1 "Open the

e VVvVYVYyYy

v

navigator", page 97

Select the LC-Transfer tab.

Select the HPLC column type used from the drop-down list.
Enter the flow rate used in the HPLC separation.

Enter the following HPLC gradient conditions:

lower and higher %B
times t1, t2 and t3

Select the cartridge you wish to use for the Flash separation from the drop-down
list.

= The cartridge is selected.

= The display shows the default flow rate.

>

Adjust the flow rate according to your needs.
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» Tap the button [Calculate].
= The display shows the results.
» Adjust the following values if necessary:

® Flow rate

» Tap the button [Accept].
= The gradient is saved for a run.
= The dialog box closes.
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